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Lesson 1: Networking Overview


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Slide 2�
Explain solutions included with Oracle9i for managing complex networks








Can we rephrase this as:





Explain the solutions in Oracle9i that can be used to manage complex networks�
Yes.  Someone else wrote this slide and I never noticed how poorly written it was.  Thanks for noticing!





Done�
�
Slide 2�
Oracle networking or Oracle Networking?�
Lower case.  Again, not a very well written item.





Done�
�
Slide 5�
“language” 





Donna: Why is language used with double quotes? If it for emphasizing can we change to italics?


�
I don’t know.  Another CD wrote this lesson.  Just remove the quotes.  Italics are not necessary.  





Done�
�
Slide 8�
OID is an LDAP, Version 3 compliant directory …





We should use the full form with the acronym in parenthesis at the first occurrence in each lesson. The sentence should be as:





OID is a Lightweight Directory Access Protocol (LDAP), Version 3 compliant directory �
You are correct.  





Done�
�
Slide 8�
Oracle can scale up to support huge user demands through the use of Oracle Connection Manager and Oracle Shared Server. 





Do you mean to say:





Oracle can scale up to support huge user demands by using Oracle Connection Manager and Oracle Shared Server.





�
Oracle isn’t using Oracle Connect Manager or Oracle Shared Server, so your rewrite isn’t really correct.  Users use the additional functionality.  How about: “You can use Oracle Connection Manager and Oracle Shared Server, to enable Oracle to support huge user demands.”





Changed to your above suggestion.�
�
Notes 8�
Oracle provides a full suite of products and tools to address most any networking need.





Can we change to:





Oracle provides a full suite of products and tools to address almost any networking need.





�
Yes.





Done�
�
Slide 9 (title) �
Connectivity: Oracle Net Services Key Features





Can we change the title to:





Connectivity: Key Features of Oracle Net Services





�
Yes.





Done�
�
Notes 13�
e-wallets





Donna: Is this a term that is used commonly?





�
As I’ve already mentioned, someone else wrote this lesson.  I assumed the correct terminology was used.  I’ve checked the OID manual and I don’t find “e-wallets” used in it.  There is mention of just “wallets”.  So change it to “wallets”.





Done�
�
Notes 14�
Oracle Shared Server was known as Oracle Multithreaded Server (MTS) in versions prior to Oracle9i.





Change to:





Oracle Shared Server was known as Oracle Multithreaded Server (MTS) in versions before Oracle9i.�
Yes.





Done�
�
Notes 15�
Multiplexing gives larger numbers of users access to a server. 





Can we change to:





Multiplexing gives large number of users access to a server.


�
No.  It needs to be a comparison. 


Change it to: “You can use multiplexing to provide access to the server to more users than would otherwise have access” or words to that effect.





Donna: I have changed to:





You can use multiplexing to provide access to the server to more users, which you would not be able to do otherwise.





Is this OK. If not, please revert to the one of your choice.





DKK - Changed to:


You can use multiplexing to provide access to the server to more users.�
�
Notes 17�
When additional clients request connections to the server through Oracle Connection Manager, they use the same connection that Oracle Connection Manager used for the initial connection.





Donna: What do they stand for?


�
“They” refers to the “additional clients” mentioned at the beginning of the sentence.





Done�
�
Notes 18�
Oracle Advanced Security is a separately licensable product.





Can we change this to:





Oracle Advanced Security is a product that is licensed separately.








�
Yes.�
�
Notes 19�
Encryption Example Using Advanced Security





Can we change the block label to:





Encryption Using Advanced Security: Example


�
I would prefer: 


Example: Encryption Using Advanced Security





Done�
�
Notes 19�
This example shows one of the major tasks of a secure…





Can we change this to:





The example in the slide shows one of the major tasks of a secure…


�
Yes.





Done�
�
Notes 20�
Shouldn’t the block label be Oracle Net Services and Firewalls instead of Oracle Net and Firewalls?


�
It doesn’t really matter.  But to be consistent with the slide title, you should change it.





Done�
�
Notes 20�
Oracle environments





Donna: What do you mean by Oracle environments? Is it an acceptable usage?





�
I assume he meant “installations”.  So please change “environments” to “installations”.





Done�
�
Notes 20�
Intranet applications





Donna: I have changed it to intranet applications.


�
OK.�
�
Notes 21�
….environments other than Oracle…





Donna: What do you mean by environments other than Oracle? Is it an acceptable usage?�
The “environments” are what is listed in the bullets below the sentence.  Non-Oracle database management systems, non-Oracle systems and services, etc.�
�
Notes 24�
Oracle Net Manager is a tool to help you configure and manage the Oracle networking environment.





Can we change this to:





You can use Oracle Net Manager to configure and manage the Oracle networking environment.�
Yes.





Done





DKK - This was not done.  I have changed it.�
�
Notes 24�
Oracle Names server or Oracle Names Server?





It should be Oracle Names Server if it is the complete name of a product.�
Lower case for “server”.  The product is called Oracle Names.  See the Oracle Net Services documentation at: http://st-doc.us.oracle.com/9.0/920/network.920/a96580/config_c.htm#483057





Done�
�
�
�
�
�



�






Lesson: 2


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Slide 4�
Oracle Database Server





Donna: What is Oracle Database Server? Is it Oracle database or Oracle server?


�
It is Oracle Database Server.  This is the terminology used in the Oracle Net Services Administrator’s Guide.  You can refer to it at: http://st-doc.us.oracle.com/9.0/920/network.920/a96580/architec.htm#1041562





Retained the original usage.�
�
Notes 11�
For example, the Oracle Internet File System allows one to present the database content to the client over a variety of protocols, including HTTP.





Can we change this to:





For example, you can use the Oracle Internet File System to present the database content to the client over a variety of protocols, including HTTP.�
Yes.





Done�
�
Slide 14, Notes 14�
Oracle Names server or Oracle Names Server?





It should be Oracle Names Server if it is the complete name of a product. Change to the correct format throughout the lesson.�
No – it is not Oracle Names Server.  It is Oracle Names server. Lower case for “server”.  The product is called Oracle Names.  See the Oracle Net Services documentation at: http://st-doc.us.oracle.com/9.0/920/network.920/a96580/config_c.htm#483057





Retained the original usage�
�



�



Lesson: 3


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 3�
The Listeners page under the Nodes folder in the Navigator displays listener properties for a node selected in the Navigator. 





Donna: Have you bold wrapped Listeners and  Nodes for the purpose of emphasizing them? Assuming so, I have changed them to italics as per OU Style Guide requirement.�
No, it is to indicate the page names.  Please do not make them italics.





Retained the original usage�
�
Notes 8�
process/thread





process and thread or process or thread?








�
Process or thread.





Done�
�
Notes 9�
If a redirect session is established with shared servers, a new process may not necessarily be spawned as stated in step 2 if there is capacity remaining on the shared servers that are running.





Donna: What do you mean by if there is capacity remaining? Can we rephrase this?


�
It means if the shared servers can handle the request.  I’m not really sure how to rephrase this.





Retained the original usage�
�
Notes 12�
The listener.ora file is used to configure the listener for static service registration.





Can we change this to:





You can use the listener.ora file to configure the listener for static service registration.


�
Yes.  Although they don’t have a choice.  I think the phrase “you can use” suggests a possible thing that can be done.  The listener.ora file must be used. 





Donna: I have changed can to must as you have said the user do not have any other choice.





You must use the listener.ora file to configure the listener for static service registration.�
�
Slide 17�
Configure Services





Can we change the slide title to Configuring Services?


�
Yes.





Done�
�
Notes 17�
Click the Add Database button.





Change to Click Add Database.


I have changed this in Notes 16.


�
OK.





Done�
�
Notes 17�
Select Save Network Configuration from the File menu of Net Manager. 





Shouldn’t we say Oracle Net Manager?�
Yes.  It is referred to both ways in the documentation.





Done�
�
Notes 23�
lsnrctl command 





lsnrctl command  or LSNRCTL command?


�
Lower case.





Retained the original usage�
�






Lesson: 4


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 13�
Oracle Corporation recommends that you use the default setting of Database Default for the connection type. 





Donna: According to the OU Style Guide we should not personify the term Oracle. Can we change this to:





You should use the default setting of Database Default for the connection type.


�
OK.





Done�
�
Notes 13�
Shared Server or shared server?�
Shared Server.  It should not be bold.


Done


DKK- One was missed.  I changed it.�
�
Notes 24�
vi or Vi or VI?





Isn’t this the name of the editor?�
Yes, it is the editor.  It should be lowercase.





Done�
�



�






Lesson: 5


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
�
The program interface in use here depends on whether the user and the dedicated server processes are on the same machine.





Can we rephrase this as:





The program interface that is in use in dedicated server processes depends on whether the user and the dedicated server processes are on the same machine.





Donna: Accept this only if the technical meaning is not changed.


�
What page?





Sorry. This is in Page 4. 





Because I was not sure about your call on this, I haven’t changed the sentence. Please change it.





DKK- I have changed it to:


The program interface that is in use depends on whether the user and the dedicated server processes are on the same machine.�
�
Notes 8�
When to Use a Dedicated Server





Shouldn’t this be





When to use a dedicated server:


�
I think it was a block label, so it should have been bold.  However, it doesn’t really need to be a block label.  So your suggestion is fine.





Done�
�
Notes 14�
Further details on the DISPATCHERS parameter can be found in the “Initialization Parameters” section in the Oracle9i Database Reference document.





Donna: By document do you mean manual? Can we rephrase this sentence as:





For more information on DISPATCHERS parameter, refer the “Initialization Parameters” section in Oracle9i Database Reference. �
Yes, I meant the manual. The “manuals” are referred to as “documentation”. 





Your rephrasing is missing a few words.





For more information on the DISPATCHERS parameter, refer to the “Initialization Parameters” section in the Oracle9i Database Reference manual. 





Done


DKK-I changed to the title to italics.�
�
Notes 19�
If you omit the parameter or set it to 0, Oracle does not start any shared servers at all





Please specify if it is Oracle server or database. You have used Oracle throughout this page without specifying if it is the server or the database. 


�
Reword as follows:


If you omit the parameter or set it to 0, no shared servers are started.





If you set SHARED_SERVERS to 0, all current servers are terminated when they become idle and no new servers are started until you increase SHARED_SERVERS. 





 Done


�
�
Notes 30�
Telnet session or telnet session?�
Lower case.





Done�
�









�



Lesson: 6


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Slide 2�
Oracle environment





Donna: What do you mean by Oracle environments? Is it an acceptable usage?�
This same slide has been used for over 5 years in the various versions of the backup and recovery course.  Isn’t interesting that no one has ever questioned the use of the word “environment” before?  So I would say that it is fine!





Retained the original.�
�
Notes 3�
One of database administrator’s (DBA) major responsibilities is to ensure that the database is available for use. 





Can we change to:





One of  the major responsibilities of a database administrator (DBA) is to ensure that the database is available for use. 


�
OK.





Done�
�
�
�
�
�
�
�
�
�



�












Lesson: 7


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 7�
Set this initialization parameter only if Oracle reports an error in the 	alert.log stating that it does not have enough memory and that it will not start I/O 	slaves.





Please specify if it is Oracle server or database. You have used Oracle throughout this lesson without specifying if it is the server or the database. �
It should be obvious. The “database” can’t really do anything!  It is simply a collection of files.





Retained the original


DKK-I removed “Oracle” completely. �
�
Notes 33�
In the Standard Edition, this column is always NULL.





What do you mean by Standard Edition? Can you make it more clear?�
This is the exact definition from the Oracle9i Database Reference.  Refer to the following:


http://st-doc.us.oracle.com/9.0/920/server.920/a96536/ch383.htm#1093134





Here is information from the Oracle9i Database New Features Release 2 manual:


“The Oracle9i database is available as Oracle9i Enterprise Edition, Oracle9i Standard Edition, and Oracle9i Personal Edition. Each database edition includes a wide set of database features.”  URL: http://st-doc.us.oracle.com/9.0/920/server.920/a96531/ch5_edit.htm#73594





Retained the original


DKK- I changed it to Oracle9i Standard Edition.�
�
�
�
�
�
�
�
�
�
�
�
�
�












�









Lesson: 8


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 6�
A filled redo log file cannot be reused until a checkpoint has taken place…





What do you mean by filled?


 Do you mean filed?�
The redo log file is full.  No, I don’t mean “filed”.





Retained the original.�
�
Notes 34�
ARCHIVELOG mode





Shouldn’t mode names be in Courier New?�
NO.  Do not put ARCHIVELOG or NOARCHIVELOG in CN!





Retained the original.�
�















Lesson: 9


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 7�
•From the Console’s Object > Backup Management menu.


•From the Console’s Tools > Database Tools > Backup Management menu.





Donna: Shouldn’t we specify the action on these steps? Can you please rephrase.


�
As stated in the lead-in sentence, “You can access the Backup Management wizards and property sheets by using one of the following methods:”.  So the point is that you can get to the wizards and property sheets from the Backup Management menu.  And you get to it either of the two ways mentioned.  By the way, this is what is shown in the screen shot.





Retained the original.�
�
Notes 17�
With Recovery Manager you can connect to the following types of databases: 





Change to:





You can use the Recovery Manager to connect to the following types of databases:


�
OK.  Just remove “the” before “Recovery Manager”.  It is not referred to as “the Recovery Manager”; it is “Recovery Manager”.








Done�
�
Notes 17�
You are connected to the target database with the SYSDBA privilege. 





Can we say:





You should connect to the target database by using the SYSDBA privilege.


�
No, that isn’t really the point.  Please change it as shown below.


Target database. Note: You are connected to the target database with the SYSDBA privilege. You must have this privilege for the connection to succeed. 





Retained the original.�
�









�



Lesson: 10


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 5�
Oracle recommends using RMAN for all backup and recovery operations, but supports user-managed backup and recovery methods.





Donna: According to the OU Style Guide we should not personify the term Oracle. Can we change this to:





You should use RMAN for all backup and recovery operations, but supports user-managed backup and recovery methods.�
The sentence doesn’t make sense the way you’ve reworded it.


It can be changed to the following:


You should use RMAN for all backup and recovery operations, although user-managed backup and recovery methods are supported.


Done�
�
�
Backup sets can include one or more data files, the control file, or archived redo log files. The backup set can contain one or more files. 


�
Page number?  Question?  Is this a repeat of the next one?





Yes, please ignore.�
�






Lesson: 11


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 4�
Backup sets can include one or more data files, the control file, or archived redo log files. The backup set can contain one or more files. 





Donna: Can we delete the second sentence as the info is already given in the first sentence? 


�
DO NOT SEPARATE “DATA” and “FILE”!!  I notice in this example, it is “data file”.  In my copy, it is “datafile”.  DO NOT make it two words.  If you’ve changed it throughout the course, change it back!  It is “datafile” in all of the Oracle documentation.





Regarding, this question – Yes, delete the second sentence.





Done. �
�
Notes 10�
Specifies a maximum size for a backup set in bytes (default), kilobytes (K), megabytes (M), and gigabytes (G). 








Have you used K, M, G  as the short forms for kilobytes, megabytes, and gigabytes? If yes, please change them to KB, MB, and GB respectively.�
The syntax is K, M, and G not KB, MB, and GB.  I have listed it correctly.





Retained the original�
�
Notes 18�
integer times





Donna: Please check the font of integer? Why is it in AriaUnicode MS?


�
Please change it.  It was a “cut and paste” operation from the online documentation.





Changed to TNR.�
�
Notes 14�
Donna/DTP: Please check the fonts of the code list. Shouldn’t it be 12pts?�
This is the font size in the template!  See page 40 of the OU5.2 template!!





Retained the original�
�
Notes 34�
If CONFIGURE CONTROLFILE AUTOBACKUP is ON, RMAN automatically backs up the control file and the current server parameter file in these situations: 


•After every …


•Whenever a BACKUP…


•At the end of every RUN …


•After database structural changes …





Donna: Can we delete in these situations? This will help the lead-in sentence to connect to each point as in the following:





If CONFIGURE CONTROLFILE AUTOBACKUP is ON, RMAN automatically backs up the control file and the current server parameter file: 


•After every …


•Whenever a BACKUP…


•At the end of every RUN …


•After database structural changes …�
Yes.





Done�
�



�



Lesson: 12


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 23�
Proceed as follows to recover the database:





Can we change this to:





To recover the database, perform the following steps:


�
Yes, much better.  This is a page from one of the old versions of the backup and recovery course.  I’ve seen it this way for so long that I didn’t even notice how poorly it was written!  Thanks.





Done�
�



Lesson: 14


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Slide 21 �
Recover the database until cancel.





Donna: What do you mean by until cancel?





�
“Until cancel” is one type of incomplete recovery.  This has been discussed throughout this lesson.  So what this sentence really means is:


Recover the database using the “until cancel” option.  You can see this on page 22.





Retained the original


DKK-I changed it to “using UNTIL CANCEL”.�
�
Notes 21�
Use the steps below to rectify this situation:





Can we change as:





To rectify this situation, perform the following steps:


�
Yes.





done�
�
Notes 25�
Donna/DTP: Please check the font size of the code elements in this page. Shouldn’t it be 12?�
It doesn’t fit if it is 12.  Please leave it at 11.  I’ve used smaller font sizes where I need to fit all of the command on one line.





Retained the original�
�



�



Lesson: 16


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 18�
1.Connect to your database in the default Nocatalog mode.





Nocatalog mode or NOCATALOG mode???


�
NOCATALOG.�
�
�
�
�
�
�
�
�
�









Lesson: 18


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 8�
For a full treatment of modes and objects, see the Oracle9i Database Utilities document.





Donna: Can we rephrase this as:





For more information on a full treatment of modes and objects, refer the Oracle9i Database Utilities manual.


�
No, the sentence doesn’t make sense as you’ve rephrased it.  Also, “to” is missing. You can rephrase it as follows:


For more information on modes and objects, refer to the Oracle9i Database Utilities manual.





Done�
�
Notes 12�
The Export Wizard, one of the Data Management wizards, guides you through the process of specifying what you want to export and submits an Export job through Enterprise Manager to complete the operation.





Can we rephrase as:





You can use the Export Wizard, one of the Data Management wizards, to specify what you want to export and submits an Export job through Enterprise Manager to complete the operation.





Donna: Accept this only if the technical meaning is not affected.


�
Yes, this is much better.  Just change “submits” to “submit”.  Thanks.





Done�
�
�
�
�
�










































�



Lesson: 19


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 10�
Use tracing sparingly and trim the trace files regularly because of their potential for rapid growth





Donna: The meaning is not very clear. Can you please rephrase this.�
I didn’t write this part.  I think it would be better as two items:


Use tracing only when needed


Trim the trace files regularly because of their potential growth.





Done�
�
�
�
�
�
�
�
�
�












Lesson: Appendix A


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 11�
The large pool is an area of the SGA that can be used for buffering information in memory for Recovery Manager when IO slaves are required





Donna: Is IO the abbreviation for input/output? If yes, we must change it to I/O.�
Yes, it should be I/O.





Done�
�






Lesson: Appendix B


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 15�
For more information, see the following publications:





Can we rephrase this as:





For more information, refer the following:





If acceptable, this should be applied to Notes 16 and Notes 21 also.


�
OK – but you left out the “to” again.  It should be:


For more information, refer to the following:





By the way, that phrasing has been in this section of the course for over 5 years.





done�
�
�
�
�
�
�
�
�
�






Lesson: Appendix C


Location�
Original Item /


Suggestions, Query, Change to�
CD/s comments�
�
Notes 3�
See the SQL Reference for details.





Can we rephrase this as:





�
Rephrase as????





Retained the original�
�
�
�
�
�
�
�
�
�






